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1 INTRODUCTION
This document describes the installation and use of the Digigram PCI Express ALP-AES67 card under
Windows and Linux.

This card is part of the ALP-X professional sound cards range.

Copyright 2024 Digigram. All rights reserved.

No part of this manual may be reproduced without the prior consent of Digigram. This reservation includes
photocopying, translating and/or reformatting the information contained in this manual.

Everything possible has been done to ensure the greatest accuracy, however Diagram cannot be held liable
for any error or omission and reserves the right to make modifications and improvements without prior
notice.

Digigram and the Digigram logo, ALP-AES67 are trademarks or brand names of Digigram Digital. All other
marks are owned by their respective companies.
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2 IMPORTANT NOTICE
Certifications
The product is currently being certified.

This product has been designed in accordance with the following standards:

● EMC Directive 2014/30/EU.
● FCC Rules Part 15, Subpart B.

To ensure compliance with the standards listed above, the following rules must be followed:

● The cable supplied must not be modified.
● The additional cables used must have their respective shielding connected at each end.

Caution
An electrostatic discharge (ESD) can damage the card components. Take the
following precautions to avoid such damage when handling the card:

Connect the card and everything entering into contact with it to the earth potential by providing a
conductive surface and discharge paths. Take these precautions as a minimum:

● Unplug all power and signal sources.
● Place the card on an earthed conductive work surface.
● Connect to the earth potential using an anti-static strap or by holding an earthed object.
● Earth all the tools entering into contact with the card.

Given the shortened length of the PCI EXPRESSTM connector and the resulting lack of
mechanical stability, we strongly advise against transporting the cards installed in a
computer, unless its chassis or case has a device for holding the card firmly in place to avoid
material damage.
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3 BOX CONTENTS
Thank you for purchasing a DIGIGRAM sound card in the ALP-X range.

The box contains:

● The ALP-AES67 sound card equipped with a low-profile bracket (79.2 mm),
● The expansion card for 2 Eth ports equipped with a low profile bracket

(the expansion card can be linked to the main board via the flat ribbon cable).
● a standard height bracket (full height: 120 mm) that can be fitted instead of the low profile

one, and that receives the four Eth ports

4 GENERAL CHARACTERISTICS
ALP-AES67 is a low profile PCI EXPRESSTM x1 sound card. It can be inserted into and therefore
operate in PCIe® x1, x4, x8 or x16 slots.

4.1 Main hardware characteristics
● Low profile PCIe x1
● Two Gbps Eth ports of the main board (PCIe slot).
● Two additional ports on the expansion board.
● The main board and the expansion board can have their own low profile brackets.
● The main board and the expansion board can use the same standard height bracket.
● Inter-card synchronisation

4.2 Main software characteristics
● 64 playback channels & 64 recording channels at 44.1 and 48 kHz

32 playback channels & 32 recording channels at 88.2 and 96 kHz
16 playback channels & 16 recording channels at 176.4 and 192 kHz.
Simultaneous acquisition and playback in PCM (8, 16 and 24 bit)

● The available Eth ports can be used in switch or redundant mode
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● Low latency multi-card and multi-applications drivers
- Wasapi/DirectSound, and ASIO under Windows
- Alsa driver under Linux

● "ALP-X Manager" application installed with the Windows driver
● Embedded WEB server for configuration of the network and stream parameters

5 REQUIRED CONFIGURATION

5.1 Required hardware configuration
There are no particular hardware restrictions in terms of PC on using the ALP card and its driver. The
PC can have standard height or low profile PCIe card slots.

A PCI EXPRESSTM (PCIe®) x1, x4, x8 or x16 slot must be available to plug in the card.

The processing power and memory required depend mainly on the operating system and the
applications used on the PC.

Note: The driver of the card reports to the OS that it does not manage the Sleep mode. As a
consequence, the PC should not go to sleep mode.

In case the PC goes to sleep mode under Windows, please proceed as follows to disable the sleep
mode.

The windows sleep mode for the PCIe bus must be disabled.

Go to Windows Settings, System, and select “Power & sleep”.

Select Never” for the option “Put the computer to sleep”.

On the same window, click on “Additional power settings”.

7



User Manual for ALP-AES67

Click on “Change plan
settings” in front of
“Balanced (recommended)”

Select “Change advanced
power settings”.

Select “PCI Express”, “Link
State Power Management”,
and select “Off” for the
setting.

Click on Ok to validate
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5.2 Necessary software configuration under Windows
ALP cards operate under Windows from 64-bit versions of Windows 10 from version 20H2.

To use your ALP-X card, you must install the driver included in the installation kit “ALP-X Kit”.
Download the latest version from the digigram website from the ALP-AES67 card support page.

This driver supports all the ALP cards.

The "ALP-X Kit" installer is used to install the following components:

● a 64-bit WDM driver offering the WASAPI and DirectSound application interfaces,
● an ASIO driver (32 bits and 64 bits), with its "ALP-X ASIO Settings" configuration interface.

Installing this component is optional,
● the "ALP-X Manager" application, which serves to adjust/view the ALP-X cards settings..

Installing this component is optional.

In your Windows system, It may be necessary to allow the applications to access the input
audio devices of the sound cards.
Please proceed as follows:

● Go to the Windows Settings, and select Privacy.
● Select “Microphone”
● Activate the option “Allow apps to access your microphone” as shown here-after:

It is also necessary to have the “Windows Audio Endpoint Builder” running under Windows
so that the WASAPI audio devices can be used.. On some Windows setups, this service may
not be activated by default.
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To check this, go to the Computer Management panel, Services, and browse to the line
Windows Audio Endpoint Builder.

Double click on Windows Audio Endpoint Builder to display its properties.

From the “Service status” section, if the displayed status is not running, click on Start and
then OK. Click on Cancel otherwise.
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5.3 Necessary software configuration under Linux
ALP cards are supported under the following Linux distributions, from the mentioned versions:
Ubuntu:

20.04 - kernel 5.15

22.04 - kernel 6.5

Debian

11 - kernel 5.10

12 - kernel 6.1

RHEL 9
kernel 5.14

In case you need to run the driver under another Linux distribution, please contact Digigram to get
the source code.
In case you experience issues for compiling / running the driver on your Linux distribution, we
propose a service to provide you with the appropriate driver; please contact Digigram.
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6 HARDWARE INSTALLATION
Given the shortened length of the PCI EXPRESSTM connector and the resulting lack of mechanical
stability, we strongly advise against transporting the cards installed in a computer, unless it features
a specific device for holding the card firmly in place to avoid material damage.

The card must be inserted in the computer before installing its driver.

6.1 Preparing the card
Before attaching the card in the computer, make sure the card has the right bracket (low profile or
standard profile).

Standard height configurations
By default, the card is delivered with the standard profile bracket mounted.

Low profile configurations
The card can be used with or without the expansion board. The expansion card does not need a
PCIe connector, but occupies the slot of a PCIe card, and it can be installed on either side of the
ALP-AES67 board.

On the back of the card, unscrew the 4 screws
holding the top radiator in place.
Gently remove the radiator.

Lift up the brown cover of the connector on
the main board to remove the ribbon cable
from the main board.

Unscrew the 4 screws, and remove the
standard profile bracket, and remove the
bracket.
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Install the low profile bracket on the main
board, and screw it.

If you need to use the expansion board,
install the other low profile bracket on it.

If you need to use the expansion board,
gently insert the ribbon cable on the
connector (blue section of the ribbon cable
face up) and close the clip that holds the
connection cable in place.

Position the radiator on the main board, and
screw it on the back of the main board (4
screws).

On the table, place the expansion board below
the main board,

6.2 Installing the card in the PC
Insert the card in the available PCIe slot and press to position it firmly.
In case the card is used with its expansion board, and with low profile bracket,

● place the expansion board below the main board,

● place them in the PC (only the main board is inserted a PCIe slot).

Tighten the screw(s) fixing the bracket(s) to the chassis or lock the card(s) using the device provided
for this purpose on your computer.
The cards must be firmly attached to the PC chassis.
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6.3 Internal LEDs
The ALP card features two internal LEDs on the edge of its mother board, as shown below. The state
of these LEDs can be seen when the PC cover is open.

If the card and its on-board firmware are initialised correctly, LED 1 must be lit solid green, and LED
2 must flash every second (1 Hz).
If LED 2 flashes faster (twice per second - 2 Hz), this means that the firmware version that has been
uploaded to the card is corrupted, and the card is running the backup factory firmware version. It is
then necessary to re-install the appropriate firmware version.
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7 SOFTWARE INSTALLATION UNDER WINDOWS
IMPORTANT

To install the software, you must have administrator rights on the computer.

Please visit the Digigram website at www.digigram.com to obtain the most recent driver.

Should you use a specific application developed or installed by a Digigram partner, this may mean
using a specific driver version. In this case, confirm with your application supplier which driver
version to use.

Any driver downloaded from our website has to be unpacked before installing it. Double click on the
downloaded file to start the auto-extraction utility. You can choose the default destination
(temporary Windows folder) or select another one.

7.1 Very first installation

● Switch off the computer and insert the ALP card(s) in an available PCIe slot.
● Restart the computer.
● Click on Cancel if the "New device detected" wizard appears.
● Double click on the ALP driver installation file "ALP-X Kit vxx.exe"

Click on Next to continue with the
installation.

Click on "I agree” to continue with the
installation.

In this window, select the components to be
installed in addition to the card driver.

● ALP-X Manager: application used to
configure the settings of the ALP card(s)
installed.
Some software programs may have been
designed with the ALP card settings
controls built in. In this case, it may be
recommended not to install the ALP-X
Manager application.

● ALP-X ASIO Settings: this application is
used to configure the ASIO driver
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settings. There is no need to install it if
no application reliant on the ASIO
interface is used.

The driver is installed by default in the folder
"C:\Program Files (x86)\Digigram\ALP-X".

To change this folder, click on Browse and
select a new destination.

Click on Install to continue with the
installation.

The driver and selected components are
being installed.

7.2 Updating the driver version
If you want to install a new driver version, double click on the new driver installation file "ALP-X Kit
vxx.exe" (see the detailed procedure in the hereinabove chapter “Very first installation”).

7.3 Updating the firmware
The ALP card features two on-board firmware: the “AES67” dedicated firmware, and the board
firmware. Updating the firmware can be done from the AVS-Monitor application (see chapter
Firmware update procedure). Both firmware can be updated from this application.

-

7.4 Verifying the card installation
Once the driver and card have been installed as per the process described hereinabove, you can
verify that the card is installed correctly and working properly.
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7.4.1 Presence of playback and recording devices
The audio devices exposed by the card driver are visible on the Windows Sound panel. To open it,
right click on the loudspeaker icon in the Windows taskbar and select "Sounds":

.

The audio devices exposed by the card driver are visible from the "Play" and "Record" tabs.

If the card devices are not listed in the Windows Sound control panel:

● Make sure that the card is inserted correctly in the PCI slot and screwed to the computer
chassis.

● Try to uninstall the ALP-X Kit (from the Windows control panel, Applications) and re-install it.

Playback to an output device of the ALP-AES67 can be tested by right clicking on this device and
selecting "Test". The VU-meter must then show modulation.

If several cards are installed, their devices have the same names (ALP PLAY and ALP REC), but
the name of the card associated with each device differs (different card name, no index for the
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first card, and index starting from 2 for the following cards of the same model).
In the example below, the first card in the PCIe slot enumeration order is an ALP-AES67, the
second card is an ALP442e, and the third card is an ALP882e.

First card: ALP-AES67 Second card: ALP442e Third card: ALP882e

ALP PLAY 1-2
Digigram ALP-AES67
ALP PLAY 3-4
Digigram ALP-AES67
...
ALP PLAY 63-64
Digigram ALP-AES67

ALP PLAY 1-2
Digigram ALP442e
ALP PLAY 3-4
Digigram ALP442e
...
ALP PLAY 7-8
Digigram ALP442e

ALP PLAY 1-2
Digigram ALP882e
ALP PLAY 3-4
Digigram ALP882e
...
ALP PLAY 15-16
Digigram ALP882e

7.4.2 Card detected by the Digigram ALP-X Manager
application

The ALP-X Manager application, installed with the driver, is used to control and/or view the ALP card
settings via a graphic interface. This application can be launched from the shortcut created on the
desktop or from the start menu, Digigram group. The card must appear as below if it and its driver
are installed correctly. Note that a maximum of eight ALP cards can be displayed and handled in
ALP-X Manager.

7.4.3 Card availability under ASIO
If the ASIO driver for the card has been installed (option to be selected during the installation
procedure), then the card must be detected and displayed in the ASIO control panel.
The control panel can be opened from the ASIO-based software application.
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All the present ALP cards must be listed in the "ACTIVE CARDS GROUP" selection list.

7.5 Adjusting the internal latency of the card
The internal latency of the card is determined by the duration of sample buffers the card exchanges
with the PC for playback and recording audio streams. By default, this duration is 32 sampling clock
periods (0.67ms at 48 kHz).
The lower the internal latency, the lower the global latency of the card. However, a very low latency
may lead to “choppy” audio on slow PCs. In this case it is necessary to increase the internal latency.

The internal latency of the card can be changed by electing the properties of the card, from the
Windows Device Manager:

Right click on the ALP card, and select Properties, Advanced. The following window is displayed:
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With audio processing timelog:
This option is to be used only for debugging
purposes (debugview). Do not activate it
unless requested by Digigram technical
support.

Stats: These displayed values are only for
technical investigation purposes.

Internal buffer: Size of the buffers
exchanged between the card and the driver.
The size is expressed in samples (ex: at 48
kHz, a value of 48 corresponds to 1ms buffer).
Values are from 10 samples to 384 samples.
It impacts the latency of the driver.

Internal buffer quantity: Defines the
number of buffers used by the driver. This
parameter does not impact the latency.

Pre-filled Playback buffers:
This parameter should not be modified. It
impacts the latency of the driver.

Sampling rate: Select the sampling rate of
the ALP-AES67 card. The ALP-X Manager
application must be closed before selecting a
new sampling rate value.

Select the new value, and click on “Ok”.

The PC must be restarted.

7.6 Replacing a card
If an ALP card has to be replaced by another one, it is strongly recommended to proceed as follows:

● Turn off the PC.
● Remove the card to be replaced.
● Restart the PC.
● Go to the Windows Device Manager, and select “Sound, video and game controllers”.

From the “View” menu, select “Show Hidden devices”.
Select the ALP card that was hidden and select “Uninstall”.

● Turn off the PC.
● Insert the new card.
● Restart the PC.

7.7 Changing the order of installed cards
If several ALP cards are installed, and you want to move cards from one slot to another, it is strongly
recommended to proceed as follows:
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● Turn off the PC.
● Remove the cards to be moved.
● Restart the PC.
● Go to the Windows Device Manager, and select “Sound, video and game controllers”.

From the “View” menu, select “Show Hidden devices”.
Select the ALP cards that were hidden and select “Uninstall”.

● Turn off the PC.
● Insert the cards in the appropriate slots.
● Restart the PC.

8 UNINSTALLING THE DRIVER UNDER
WINDOWS
Proceed as follows to uninstall an ALP driver version.

Please note that uninstalling a version must be done prior to the installation of another version.

From Windows Start menu, open the ”Settings” panel

Click on the “Apps” icon.

From the list of installed Apps & features, select ALP-X Kit.

Click on Uninstall.

This will remove all the ALP-X ... components
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9 CONFIGURING THE CARD UNDER WINDOWS
VIA THE ALP-X MANAGER APPLICATION
This application can be launched from the shortcut created on the desktop or from the start menu,
Digigram group.

9.1 Installed ALP cards
When the application is launched, the window below is displayed and shows all the ALP cards
installed in the PC.

If another view is displayed, click on the icon to display the list of ALP cards present and
detected.

The following settings are displayed for each ALP card detected:

● its serial number,
● the on-board firmware version,
● the size of buffers exchanged between the driver and the card (see Adjusting the internal

latency of the card).

9.2 Sampling clock
The sampling clock of the card is configurable from the Windows Device Manager. The ALP-X
Manager application must be closed before changing the sampling clock value.

Open the Windows device Manager, select the item “Sound, video and game controllers”, and right
click on your ALP-AES67 card to open its “Properties” control panel. Select the appropriate sampling
frequency values.

Select OK to apply the changes. You will be prompted to restart the computer.

Click on the clock icon to display the clock settings of each present ALP card.
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9.3 Input and output vu-meters

Click on the icon to access the "I/O Monitor" view.

This view displays the vu-meters for all input and output channels.

Input vu-meters reflect the audio modulation received from the AES67 streams routed to the
ALP-AES67 card. These are the channels to be acquired from the software application via the
recording devices.

Output vu-meters reflect the audio modulation received by the card from each software playback
device. Note that the output modulation is displayed even if the AES67 network is disconnected.

The following table lists the various possible settings from the mixer view.
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Vu-meters

Each Vu-meter displays the input signal peak-meters in dBfs.

Note that there is no clipping information that is reported. As a
consequence, the clipping threshold adjustment that can be
found from “Settings-> Audio meters” has no effect.

Click on this icon to display the concerned pair of channels as two mono
channel strips.

Click on this icon to display the concerned pair of channels as one stereo
channel strip.

Channel strip name

Click on the channel strip name and enter a new name.

Note: when a channel strip display is changed from mono to stereo, or
stereo to mono, the channel stream name goes back to the default
name.

As a consequence, it is recommended to keep the display mode used
(mono or stereo) when the channel strip names have been
changed.

9.4 Firmware update procedure
The ALP-AES67 card on-board firmware may have to be upgraded, and updates can be supplied by
Digigram and prove necessary.

The firmware update has to be done from the AVS-Monitor application, which allows applying a new
firmware through the AES67 network. AVS-Monitor is an application from the company Auvitran
which is owned by Digigram. It runs under Windows, and accesses the ALP-AES67 card through the
AES67 network. As a consequence, the NIC card selected in AVS-Monitor must be connected to the
AES67 network.

In case you have not already downloaded this application, click on the button on the right of the
“Firmware version” field, as shown on the screen capture below.
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AVS-Monitor is constantly updated on Auvitran's WEBsite. It always includes the most recent
firmware version for the card. In case the PC running AVS-Monitor is connected to the internet,
AVS-Monitor is updated.

When AVS-Monitor is started and the NIC card connected to the AES67 network is selected,
AVS-Monitor automatically detects the AES67 products on the network.

To update the firmware of the products, select “Launch Firmware manager” from the “Control”
menu.

The Firmware manager application is started.

If the ALP-AES67 card(s) appears with unchecked boxes as shown below, this means that no
firmware update is to be done.

If the ALP-AES67 card boxes are checked, then select “Update” on the bottom right of the Firmware
Manager window to start the firmware update. Do not shut down the PC hosting the ALP-AES67 card
during the firmware update.

A shutdown and restart of the computer hosting the ALP-AES67 card is necessary to take into
account the new firmware.

25



User Manual for ALP-AES67

9.5 Creating, saving and loading setting sessions
The current configuration of all settings defined in ALP-X Manager can be saved. Go to the File menu
and select "Save session as".

To load a configuration, go to the File menu and select "Open session".

To create a new configuration from blank settings, go to the File menu and select "New session".

9.6 Keyboard shortcuts
Keyboard shortcut Action

Session

Ctrl + S Save

Ctrl + Alt + S Save As

Ctrl + N New

Ctrl + O Open
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10 ASIO CONTROL PANEL for Windows
The ASIO control panel can be started from the Asio application, from the menu allowing for the
settings of the audio device and the ASIO configuration.

The ASIO settings are saved per application. The ASIO driver supports multiple simultaneous ASIO
applications, provided that they do not use the same channels.

Active cards group/Asio channels allocation

This section is used to select the input channels and output channels that
are managed by the ASIO driver and which can therefore be used by any
application based on the ASIO interface.

For every card selected from the “ACTIVE CARDS GROUP” list, click on the
"ASIO CHANNELS ALLOCATION" button and select the channels to

be used under ASIO.

To manage all the installed cards from your ASIO application, select “All
ALP Boards” from the list of cards.

A card that is not used under ASIO can be used from a WASAPI or
DirectSound application.

Buffer size (latency)

This section is used to select the size of audio buffers used by the ASIO
driver. This size is given as a number of samples and a
cross-reference in duration is indicated for a sampling frequency
of 48 kHz. The higher the buffer size, the higher the latency.

A small buffer size can lead to breaks in audio throughput on a
low-powered machine or on a machine with a high processor load.

Buffers sizes followed by the symbol * cannot be selected. A smaller
internal buffer size must be selected from the Windows Device
Manager, Sound, video and games controllers , ALP-AES67
advanced settings.
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Sample size

This setting defines the format of samples exchanged between the
application and the card driver.

Enable Direct Monitoring Control

This feature has no impact on the ALP-AES67. The hardware monitoring is
not supported.

Boost ASIO priority
This option allows the system to run the ASIO process with high
priority, thereby increasing the reliability of this process. Caution,
however, this can make other processes unstable.

Audio errors

This section is used to visualise current errors for playback and recording
via the ASIO driver. Errors frequently reflect too small an ASIO
buffer size for the system's possibilities. Should they occur, then
the buffer size needs to be increased until there are no more
errors.

Sync status errors reflect clock synchro errors (AES11 external clock,
WordClock or inter-card synchro).

Error counters can be reset to zero by clicking on the RESET button.

Lastly, a time counter displays the time elapsed since the last counter
reset.
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11 ALP-AES67 principles

11.1 Embedded routing matrix

The inputs of the on-board routing matrix are:
● 64 playback channels coming from the software playback audio devices used by the application based

on the ALP driver running under Windows or Linux.
● 64 channels coming from the network interface 1 (or interfaces 1 & 2 when they are configured in

redundant mode). Audio channels are extracted from the IP streams to be received and which are
named “Sinks”.

The outputs of the routing matrix are:
● 64 channels assigned to the software recording audio devices used by the application based on the ALP

driver running under Windows or Linux.
● 64 channels assigned to the network interface 1 (or network interfaces 1 & 2 when they are configured

in redundant mode). These channels are the audio sources of the AoIP streams published to the
network 0. These streams are named “Sources”.

11.2 Clock
The ALP-AES67 can be slaved to the PTP clock, or master PTP clock on the network.
Slave to PTP clock: the source clock is the PTP clock.
Master PTP Clock: the clock source has to be internal, WordClock, or MADI, and the card is elected as Master
PTP on the network if its PTP clock has a higher priority than other potential Master PTP clock units on the
network.
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CONFIGURATION OF THE AoIP PARAMETERS
The network parameters of ALP-AES67 can be configured through its embedded WEB server, which is
accessible from any of the two Eth ports.

To access the WEB interface of the ALP-AES67 card, connect the PC network interface to the network your
ALP-AES67 is connected to.
The ALP-AES67 Eth ports are by default in DHCP mode. In case there is no DHCP service on your network, the
ports are in APIPA mode (Automatic Private Internet Protocol Addressing), with the range of IP addresses
169.254.0.0/16

You can use an application such as MT Discovery to detect the card and access its WEB pages:

The following page is displayed.

The settings are accessible via different tabs:
General settings, PTP, ASIO clock, Session sources, Session sinks, Ins/Outs, I/O router, Statistics, NMOS,
System
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12.1 General settings

Parameter Description

Device Name This is a unique device name. Other devices on the network see this device
name. We recommend not exceeding 32 characters.

Audio Configuration

Sample Rate Non modifiable.
Reflects the current sample rate (44100-48000-
88200-96000-176400-192000-352800-384000 Hz) that is set from the
ALP-AES67 properties on the driver side.

Frame size (@1Fs) Current frame size (64 - AES67/48 - 32 -16 - 12 -6).
Note that available frame size values may not be available or differ according
to the device and/or firmware.

Session Sinks Global

Safety Playout Delay (@1Fs) Additional playout delay. The value is described at 1Fs (44.1-48 kHz) in
samples.
For example, if the value is 10, the additional playout delay will be 20 at 2Fs
(88.2-96 kHz), 40 at 4FS (176.4-192 kHz),...

SSM (requires IGMP v3) Source-Specific Multicast.
If you activate this option, make sure your network switch supports and is
configured for IGMP V3.
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Network

Multi-Interface mode Activate / deactivate ST2022-7 mode

Interface 1-2 (Interface 2 is displayed if “Multi-interface mode” has previously been enabled and applied)

Link Status

Name Information only - can't be modified

Type Defines the type of IP V4 address used (Zeroconf - DHCP- Static)

Address To be set only if Type is set to Static.
Otherwise, these fields display the assigned values.

NetMask

Gateway

Reboot is required to apply the changes

.

12.2 PTP settings

Parameter Description
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Global

PTP Domain Allows to define a specific PTP domain, usually when several PTP masters
are required in the same network (default value is 0).

DSCP PTP DSCP. Values:
46-EF : PTP AES67
48-CS6: PTP RAVENNA
56-CS7

Master

Manual This checkbox must be checked to modify the PTP settings

Priority 1 Main priority value (1= Highest priority; 255=lowest priority)

Class Device class. This value should not be modified

Accuracy Non modifiable

Priority 2 Only used if the other parameters do not allow for the election of a PTP
master.

GMID Non modifiable. Current GrandMasterID (PTP Master)

Slave only Forces ALP-AES67 to always be PTP slave

Delay Mech PTP Profile related - E2E or P2P

Announce PTP announcement interval (1 - 2 - 4 - 8 -16 seconds)

Sync 0.0625 - 0.125 - 0.25 - 0.5 seconds

Status

GMID Non modifiable. Current GrandMasterID (PTP Master)

Lock Shows if the device is locked to PTP (Locked -Locking - Unlocked)

Interfaces 1 & 2

PTP status Master : Device is Master
Slave : Device is Slave
Listening : The interface is not used for synchronization

Statistics The graph is only active in slave mode.
Green curve: shows the audio clock delay vs the current Master PTP clock.
Grey curve: shows the network delay vs the current Master PTP clock,
before the device synchronisation algorithm.

12.3 ASIO Clock
This tab allows setting the parameters of the clock that can be generated for MERGING
AUDIO DEVICE software synchronization.
If this software is not used in your system, just disable this feature (Multicast clock = Off).
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Parameter Description

Global

Multicast Clock Off, On, Auto
Allows to enable/disable the multicast ASIO clock.
Auto activates the ASIO clock only on the master PTP device.

Address Multicast address of the ASIO Multicast Clock

DSCP Allows setting the ASIO Multicast Clock DSCP value: 34 (Default), 46, 48,
56.
When using a switch, make sure that the ASIO Clock DSCP has a high value
in the switch DSCP to Queue table
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Session sources
This page allows for the declaration of session source instances on the ALP-AES67 (transmitters that generate
the IP streams).

Click on the button to create a new session.

Parameter Description

Enable Enables the selected source (active by default)

IO Non modifiable (Stream)

Name Source name (63 characters max).

Output interface(s) Select the network interface (1, 2, or 1&2 in case of ST_2022-7) used for
streaming this session.

Auto-unicast Automatically retrieves the IP address of the sink (listener) for a unicast
connection

Address / User defined Check “user defined” to manually enter or modify the multicast IP address of
the generated stream.

Address sec / User defined Not accessible if only one Eth interface is enabled.
Check “user defined” to manually enter or modify the multicast IP address of
the redundant stream (ST-2022-7).

TTL Time to Live (also called Hop Limit) - this value should not be modified

Payload type RTP Payload type - this value should not be modified

Codec L24 - L16 - DSD64 - DSD64_32 - DSD128 - DSD128_32 - DSD256 (bit rate).
Note that those values are sampling rate dependent;

Frame size (samples) Frame size of the current source. Reflects the frame size set from the
General settings section.

DSCP Ip audio stream DSCP value (34: RTP AES67 / 46: RTP Ravenna / 26 / 0)

RefClk PTP traceable This feature is useful when you want to connect a stream through the
Internet (e.g. with two PTP Masters (GPS) at each location). It allows making
connections with devices locked to different traceable PTP Masters.
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See also “Ignore refclk GMID” - accept source locked to any PTP master
on the Session Sinks section below.

Channels

Channels: Channel count Number of channels in the stream.
The “Channel count” drop down menu allows selecting the number of
contiguous channels from the 64 available channels.

Routing table The routing table allows for the selection of the content of each channel of
the stream, among the 128 possible output channels of the ALP-AES67
internal matrix.
The first 64 displayed channels are software playback channels.
The following channels are the channels received from declared sinks.
In the picture above, the channels to be streamed are channels 3 & 4(named
DAW Play 3 & DAW Play 4) from the playback application on the PC.
Note that the channels can be selected from the sinks receivers, listed after
the DAW channels.

The URL of the SDP of this
session is

Allows saving the Session Description into a file (useful for specific third
party devices if manual SDP has to be provided).
Note :
Devices in 2022-7 mode will produce a 2022-7 SDP, containing both
interfaces session parameters.
If you load such SDP in a non-2022-7 device, only the session parameters
from interface1 will be used.
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12.4 Session sinks
This page allows for the declaration of session sinks (receiver instances) on the ALP-AES67.

Click on the button to create a new session.

Parameter Description

IO Non modifiable (Stream)

Label Sink name (=receiver name)

Source Drop down menu to select a source (both sap and bonjour advertised
sources are listed).

Source: Manual Allows to manually enter a SDP

Delay (samples) Playback delay.
0 is an automatic delay (works with devices based on the AES67 technology
from Merging Technologies).
If set to 0, and when using devices that are not based on the Merging
Technologies technology, the playout delay is calculated based on the value
a=framecount in the SDP.
In any case, the frames must be time aligned; all devices must run an integer
number of frames from time zero (epoch).

Ignore refclk MGID: - accept
source locked to any PTP
master

This feature is useful when you want to connect a stream through the
Internet (e.g.with two PTP Masters (GPS) at each location), it allows making
connections with devices locked to different traceable PTP Masters.
See also RefClk PTP traceable on the Session Sources page.

Ignore refclk MGID: - accept
source locked from
any PTP master

This feature is useful when you want to connect a stream through the
Internet, it allows for connections with devices locked to different PTP
domains.

Relaxed check Allow connection to a source that has less channels

Channels: Channel count Number of channels in the stream.
The associated drop down menu allows selecting the “Channel count”
contiguous channels from the 64 available channels.
Received channels can be routed towards the DAW recording channels, or
towards the declared source streams listed after the DAW rec devices:
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Channels: Count adapted To be used if the number of channels does not match

Session Info

Session status

Interface 1-2

RTP Status Connection status. The displayed value is the sum of the following error
value:
0x10 receiving RTP packets
0x01: wrong RTP sequence id
0x02: wrong RTP SSRC
0x04: wrong RTP payload type
0x08: wrong RTP SAC
0x20 stream has been muted
0x40: Horus implementation - an incoming stream is muted
0x80: ST2022-7 mode only - both interfaces are not receiving RTP packets
properly→muted
Exemple. : Stream muted (0x20) and Wrong payload (4) will be displayed as
0x24

Clock domain PTP clock type and domain

Address Multicast IP address of the selected sink

Payload Payload / Codec / Sampling Rate / Number of channels

SDP Displays the detailed SDP information on the current stream.
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12.5 Ins / Outs
This page allows you to change the name of the Inputs and / or Outputs.

12.6 I/O Router

This page allows configuring the routing from the input channels of the internal matrix to its
output channels.
An input channel can be routed to several output channels.
But multiple input channels cannot be routed to an output channel (no mixing on the output
channel).
The input channels of the matrix are listed vertically on the left. The scroll bar on the right of
the page allows scrolling down/up.
The output channels of the mixer are listed horizontally. The scroll bar at the bottom of the
page allows scrolling right/left.
To access the input channels coming from the received streams, scroll first down until you
see the horizontal scroll bar.
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12.7 Statistics
This page gives statistics about the sinks (received IP streams).
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12.8 NMOS
This page allows configuring the NMOS settings for discovery/registration, and for device connection
management.

Parameter Description

NMOS General Settings

Enable Enable or disable the NMOS client, following the Port and Registration
server configuration.
NMOS must be disabled to modify the registration server settings.

Port ALP-AES67 NMOS communication port

Flush streamer address on
disable

Clears the streamer address when the stream is disabled. This option might
be useful with some NMOS servers

Configure Registration Server

Mode Registration Server communication modes :
● mDNS(Bonjour): Automatic communication to a Registration Server,

using Bonjour service (The server needs to advertise with Bonjour
Service)

● Search domain: A search domain needs to be supplied.
The search domain associated with the primary network interface is
shown as Suggested.

● Static Address: The registration server is found using the address given
in the “Address” field.
This is currently the preferred and most common way to establish
communication with a NMOS Registration Server. (Sony NMOS CPP,
RiedelNMOS,...)

Address When Mode is set to Static Address, this allows the user to enter the server
IP address and port (<ip address>:<port number>).
In other modes, this field only displays information when the communication
is established.

Search Domain When Mode is set to Search Domain, this allows the user to enter a domain
(Unicast DNS).
In other modes, this field only displays information when the communication
is established.

Registration Server (This section provides status information about the Registration Server)
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Server Name / Host Provided by the Server (with DNS or mDNS). Note that this field may remain
empty when Mode is set to static

Address / Port Server IP address and Port

Registered True if a registration server can be reached

12.9 System

Parameter Description

Build number Current firmware version.

Configuration file

Download/upload Save/Load a configuration file (preset)

Commands

Reboot Restart the device

Reboot to factory Restore all settings to factory default, and restart the device

Save save the current configuration.

Debug

Get report Generates a debug report, and saves it on the local computer.
If the report is not saved automatically, make sure your web browser did not
block the download

Get device status Displays the device status (SysLog)

Get device engine status Displays the device engine
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13 SPECIFICATIONS

13.1 Configuration
Bus/Format PCI EXPRESSTM x1 / Low profile

(compatible x2, x4, x8, x16)

Dimensions 168 mm × 69 mm x 20 mm

Consumption (+3.3 V/+12 V) 0.4 A / 0.3 A

In operation: temperature/humidity
(without condensation) 0°C/+50°C • 5%/90%

Storage:
temperature/humidity
(without condensation)

-5°C/+70°C • 0%/95%

13.2 Audio characteristics
Sampling frequency 44.1, 48, 88.2, 96, 176.4, 192 kHz (set from Windows Device

Manager, ALP-AES67 card properties)

Audio formats supported PCM: 16, 24, 32 bits

13.3 Connectors
Internal connectors Inter-card synchronisation

External connectors 4 x Gbps RJ-45 connectors
Either located on the standard height bracket, or 2 per low
profile bracket (main board, and expansion board).
Expansion board may not be connected if the two ports are not
required.

13.4 Development environment

Drivers Windows: WASAPI, ASIO
Linux: Alsa

Operating systems supported Windows 10 from version 1809
Linux (Ubuntu 20.04, 22.04, ebian 11
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14 APPENDICES

14.1 LEDs
The ALP card has four green LEDs: two LEDs on the PCB (only visible when the PC is open) and two LEDs
on the bracket as illustrated in the diagram below.

Bracket LEDs

Internal LEDs

If the card and its on-board firmware are initialised correctly, LED 1 must be lit solid green, and LED
2 must flash every second (1 Hz).
If LED 2 flashes faster (twice per second - 2 Hz), this means that the firmware version that has been
uploaded to the card is corrupted, and the card is running the backup factory firmware version. It is
then necessary to re-install the appropriate firmware version.

LED Description Behaviour

LED 1 Signals when the card is initialised correctly Solid green lit
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LED 2 Signals if the card is running the last updated
firmware or the backup factory firmware
version.

● Flashes every second:
The card runs the last uploaded firmware version
(normal behaviour).

● If this LED flashes differently, the card runs the
backup factory firmware instead of the last uploaded
version This last firmware is corrupted in memory
and has to be applied again.
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14.2 Connectors
Card equipped with the low profile bracket.

Without the expansion card With the expansion card (low profile brackets)

Card equipped with the standard profile bracket

Eth connectors

Mode J1 J2 J3 J4

Switch Primary Switch Switch Switch

Redundant Primary Secondary Switch Primary Switch Secondary

Note: Switch and Redundant modes are configured from the ALP-AES67 WEB pages.
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Please contact your distributor for all technical support issues

Digigram Digital
82 Allée Galilée, 38330 Montbonnot - FRANCE

Tel: +33 (0)4 76 52 47 47
E-mail: info@digigram.com

Digigram Asia Pte Ltd.
60 Albert Street - #09-11 OG Albert Complex Singapore 189969, Singapore

 Tel.: +65 6291 2234 • Fax: +65 6291 3433 

E-mail: info_asia@digigram.com
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